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Thank you for purchasing our product. If there is any question or request, please do not hesitate to 

contact the dealer. 

This manual applies to iVMS-4200 PCNVR. 

This manual may contain several technically inaccurate points or printing errors, and the content is 

subject to change without notice. The updates will be added into the new version of this manual. We 

will readily improve or update the products or procedures described in the manual. 
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Chapter 1 Overview 

1.1 Description 

iVMS-4200 PCNVR is designed to manage the embedded network surveillance devices, such as 

network cameras and video encoders, and provides mainly storage and management function for the 

input video stream. It functions as a NVR installed on your PC, only it does not have a specific 

hardware device and dedicated record file storage HDDs. The software cuts the complexity of the 

surveillance application, meeting the needs of small and medium scale projects.  

1.2 Running Environment 

Operating system: Microsoft Windows 7/Windows 2008(32/64-bit operating system), Windows 

2003/Windows XP(32-bit operating system) 

CPU: Intel Pentium IV 3.0 GHz or above 

Memory: 1G or above 

Display: 1024*768 or above 

Note: For high stability and good performance, these above system requirements must be met.  

1.3 Conventions 

In this document, the iVMS-4200 PCNVR software is referred as software, or PCNVR. 

1.4 Function Modules 

Main Interface of iVMS-4200 PCNVR: 
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Menu Bar: 

File 

Open Captured picture Search and view the captured pictures stored on local PC.  

Open Video File View the backup video files stored on local PC. 

Open Log File View the backup log files stored on local PC. 

Exit Exit the iVMS-4200 PCNVR software. 

AutoRun Run the PCNVR or the operating system automatically. 

System 

Lock Lock screen operations. Log in the client again to unlock. 

Switch User Switch the login user. 

Import Configuration File Import software configuration file from your computer. 

Export Configuration File Export software configuration file to your computer. 

Restore Default Settings Restore the default settings of the system. 

View 

1024*768 Display the window at size of 1024*768 pixels. 

1280*1024 Display the window at size of 1280*1024 pixels. 

1440*900 Display the window at size of 1440*900 pixels. 

1680*1050 Display the window at size of 1680*1050 pixels. 

Full Screen Display the window in full screen. 

Main View Open the Main View page. 

Playback Open the Playback page. 

E-map Open the E-map page. 

Configuration Open the Configuration page. 

Auxiliary Screen Preview Open Auxiliary Screen Preview window. 

Tool 

Import Camera Open the Import Camera page. 

Camera Settings Open the Camera Settings page. 

Record Schedule Open the Record Schedule page. 

Event Management Open the Event Management page. 
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I/O Settings Open the I/O Settings page. 

Account Management Open the Account Management page. 

Disk Management Open the Disk Management page. 

System Configuration Open the System Configuration page. 

Log Search Open the Log Search page. 

Broadcast Select camera to start broadcasting. 

I/O Control Turn on/off the alarm output. 

Soft Keyboard Enable the soft keyboard function. 

Help 

Open Wizard Open the guide for the software configuration. 

User Manual (F1) 
Click to open the User Manual; you can also open the User 

Manual by pressing F1 on your keyboard. 

About View the basic information of the software. 

Language 
Select the language for the software and the software will 

reboot automatically to activate the settings. 

 

The iVMS-4200 PCNVR is composed of the following function modules: 

 
Main View 

The Main View module provides live view of network cameras and video 

encoders, and supports some basic operations, such as picture capturing, 

recording, PTZ control, etc. 

 
Playback The Playback module provides the search, playback, export of record files. 

 
E-map 

The E-map module provides the displaying and management of E-maps, 

alarm inputs, hot regions and hot spots. 

 
Configuration 

The Configuration module is composed of 8 function sub-modules: Import 

Camera, Camera Settings, Record Schedule, etc. 

 

The Configuration module is composed of the following 8 function sub-modules: 

 Import Camera 
Add, modify and delete the network camera and video encoder; 

provide remote configuration for the added device. 

 Camera Settings 
Configure the picture settings, encoding parameters, on screen 

display(OSD) settings, PTZ control parameters, etc. 

 
Record Schedule 

Configure record parameters and set up schedule template to be 

used in recording. 

 
Event Management 

Set up recordings and alarms by defining triggers and linkage 

actions. 

 
I/O Settings Turn on/off the alarm output. 

 
Account Management 

Add, modify and delete the user accounts and assign different 

permissions for the users. 

 
Disk Management Pre-allocate the HDDs for record file storage. 

 
System Configuration 

Configure the general parameters, file saving paths, alarm sounds 

and other system settings. 
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The function modules or sub-modules are easily accessed by clicking on the navigation buttons on the 

main interface of PCNVR or by selecting the function module from the View or Tool menu. 

 

You can check the information, including current user, network usage, CPU usage, memory usage and 

time in the upper-right corner of the main page. 
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Chapter 2 Starting iVMS-4200 PCNVR 

2.1 User Login 

Steps: 

1. Input the user name and password. By default, the user name and password are admin and 

12345. 

2. Optionally, check the checkbox Enable Auto-login to log in the software automatically. 

3. Click Login. 

 

 

After running the software, a wizard will pop up to guide you to add the device and do some basic 

settings. 

2.2 Pre-allocating HDDs 

Purpose: 

PCNVR does not have dedicated storage HDDs and the record files are stored in the local disk of the PC 

running the software. The HDDs of the PC need to be pre-allocated for the record file storage. 

Steps: 

1. Click the  icon on the Configuration panel, 

or click Tool->Disk Management to open the Disk Management page. 

2. Check the checkbox to select the disk. The space usage of the disk will be displayed. 

3. Click Pre-allocate to pre-allocate the selected disk. 

4. Click OK in the pop-up dialog box to continue the disk pre-allocation.  

You can check the pre-allocation process in the process bar. 

5. Click OK in the pop-up dialog box after the pre-allocation completed and reboot the software to 

activate the new settings.  

6. Log in the software again. The status of the pre-allocated disk changes from Unformatted to 

Normal. 

Notes: 

 The total space of pre-allocated HDDs should be no less than channel number*0.5G. 

 The original data of pre-allocated HDDs will not be deleted. 
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2.3 Adding the Devices 

Purpose: 

After running iVMS-4200 PCNVR, the devices including network cameras and video encoders, should 

be added to the system for remote recording and management. 

Click the  icon on the Configuration panel, 

or click Tool->Import Camera to open the Import Camera page. 

 
 

You can add the devices in the following ways: 

 By detecting the online devices, see Adding Online Devices. 

 By specifying the device IP address, see Adding Devices Manually. 

 By specifying an IP segment, see Adding Devices by IP Segment. 

 By IP Server, see Adding Devices by IP Server. 

 By HiDDNS, see Adding Devices by HiDDNS. 

Note: Click the icon , and you can import the cameras to PCNVR from the database of iVMS-2000. 
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Adding Online Devices 

Steps: 

1. Open the Import Camera page and click Add to enter the Camera Adding interface. 

2. Select Online Detection as the adding mode. The active online cameras and video encoders in the 

same local subnet with the software will be displayed on a list. 

3. Check the checkboxes to select the devices to add. 

You can click Refresh to refresh the information of online devices. 

4. Input the device user name and password. By default, the device user name and password are 

admin and 12345. 

5. Click Add to add the selected devices. 

The IPv6 address of the device is preferred if available. 

You can click Set Network Parameters to configure the network information of the device. 

 

 

Adding Devices Manually 

Steps: 

1. Open the Import Camera page and click Add to enter the Camera Adding interface. 

2. Select IP/Domain as the adding mode. 

3. Input the required information. 

Address: Input the device’s IP address or domain name. 

Port: Input the device port number. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. By default, the password is 12345. 

4. Click Add to add the device. 
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Adding Devices by IP Segment 

Steps: 

1. Open the Import Camera page and click Add to enter the Camera Adding interface. 

2. Select IP Segment as the adding mode. 

3. Input the required information.  

Start IP: Input a start IP address. 

End IP: Input an end IP address in the same network segment with the start IP. 

Port: Input the device port number. The default value is 8000. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. By default, the password is 12345. 

4. Click Add, and the device of which the IP address is between the start IP and end IP will be added 

to the camera list. 
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Adding Devices by IP Server 

Steps: 

1. Open the Import Camera page and click Add to enter the Camera Adding interface. 

2. Select IP Server as the adding mode. 

3. Input the required information. 

Server Address: Input the IP Server address. 

Device Name/Device Serial No.: Input either device name or device ID registered on the IP server. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. By default, the password is 12345. 

4. Click Add to add the device. 
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Adding Devices by HiDDNS 

Steps: 

1. Open the Import Camera page and click Add to enter the Camera Adding interface. 

2. Select HiDDNS as the adding mode. 

3. Input the required information. 

Server Address: www.hik-online.com. 

Device Domain Name: Input the device domain name registered on the HiDDNS server. 

User Name: Input the device user name. By default, the user name is admin. 

Password: Input the device password. By default, the password is 12345. 

4. Click Add to add the device. 

 

 

Camera Management 

The cameras will be displayed on the list for management after added successfully. You can check the 

nickname, device channel number, IP address and port of the cameras. 

Click the icon  to refresh the information of all added cameras. You can also use the search field to 

locate desired cameras. 

Click the icon /  to display the added cameras in thumbnail/list view mode. 

Select the camera from the list, click Modify/Delete, and then you can modify/delete the information 

of the selected camera. 

Select the camera from the list, click Remote Configuration, and then you can do some remote 

configurations of the selected camera if needed. 

http://www.hik-online.com/
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2.4 Configuring Record Schedule 

Purpose: 

The record schedule can be set for one or more cameras for continuous, alarm triggered or motion 

detection triggered recording. And the record files can be searched for remote playback. 

Before you start: 

Devices, including the cameras and video encoders, should be added to the software. 

Click the  icon on the Configuration panel, 

or click Tool->Record Schedule to open the Record Schedule page. 

 
 

Steps: 

1. Open the Record Schedule page. 

2. Select the camera from the list and click Edit, 

or double-click the channel in the list to enter the Modify Record Schedule interface. 

3. Select the channel name from the drop-down list.  
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4. Click Motion Settings, and click-and-drag the mouse to draw a defined area for motion detection. 

You can click the icon  to set the whole video area as the detection area, click the icon  to 

delete the selected area, or click the icon  to clear all the detection areas. 

5. Set the record parameters. For details, see Table 2.1 Record Parameters. 

6. Check the checkbox Enable Record Schedule to enable the schedule recording. 

7. Select the record schedule template from the drop-down list. 

All-day Template: for all-day continuous recording. 

Weekday Template: for working-hours continuous recording from 8:00 AM to 8:00 PM. 

Alarm or Motion Template: for alarm input triggered or motion detection triggered recording. 

Template 01-08: fixed templates for specific schedules. You can edit the templates if needed. 

Custom: can be customized as desired. 

If you need to edit or customize the template, click Edit to enter the Templates Management 

interface. For details, see Configuring Record Schedule Template. 

8. Click Advanced Settings to set the parameters of scheduled capture and event capture. 

9. Optionally, click Copy to… to copy the record schedule settings to other cameras. 

10. Click OK to save the settings. 

 

 

Table 2.1 Record Parameters 

Parameters Descriptions 

Pre-record 
Normally used for the event triggered record, when you want to record before 

the event happens 

Post-record After the event finished, the video can also be recorded for a certain time. 

Video Expired Time 
The time for keeping the record files in the storage device, once exceeded, the 

files will be deleted. The files will be saved permanently if the value is set as 0. 

Record Stream Type Record the video files in main stream or sub-stream. 

 

Configuring Record Schedule Template 

Perform the following steps to configure the record schedule template to be applied: 

If Template 01-08 is selected, start from step 1; 
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If Custom is selected, start from step 2. 

1. Click Edit. You can edit the template name. 

2. Set the time schedule for the selected template. 

 refers to the normal schedule record. The time bar is green.

 refers to the record triggered by motion detection. The time bar is orange. 

 refers to the record triggered by alarm input. The time bar is red. 

 refers to the record triggered by alarm input or motion. The time bar is purple. 

When the cursor turns to , you can edit the schedule time bar. 

When the cursor turns to , you can move the selected time bar you just edited. 

When the cursor turns to , you can lengthen or shorten the selected time bar. 

3. Optionally, you can select the schedule time bar,  

and then click the icon  to delete the selected time bar, 

or click the icon  to delete all the time bars, 

or click the icon  to copy the time bar settings to the other dates. 

4. Click Save to save the settings. 

Note: Up to 8 time periods can be set for each day in the record schedule. 

 
 

2.5 Account Management 

Purpose: 

Multiple user accounts can be added to the software, and you are allowed to assign different 

permissions for different users if needed. 

Click the  icon on the Configuration panel, 

or click Tool-> Account Management to open the Account Management page. 

Note: By default, the user account admin is the super administrator of the software and the password 

is 12345. 
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Adding the User 

Steps: 

1. Open the Account Management page. 

2. Click Add to open the User Privilege dialog box. 

3. Select the user type from the drop-down list. 2 types of user accounts are selectable: Guest and 

Operator. 

4. Input the user name, password and confirm password as desired. 

5. Check the checkboxes to assign channel permissions and other permissions for the created user. 

6. Click OK to save the settings.  

Note: Up to 32 user accounts can be added for the software. 

 

 

Managing the User 
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Purpose: 

After created successfully, the user account is added to the user list on the Account Management page. 

You can edit or delete the information of the user accounts. 

To edit the information of the user, select the user from the list, and click Modify. 

To delete the information of the user, select the user from the list, and click Delete. 
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Chapter 3 Live View 

Purpose: 

For the surveillance task, you can view the live video of the added network cameras and video 

encoders on the Main View page. And some basic operations are supported, including picture 

capturing, manual recording, PTZ control, etc. 

Before you start: 

A camera is required to be added for live view. 

Click the Main View tab, 

or click View->Main View to open the Main View page. 

 
Main View Page 

1 View List--Default View and Custom View 

2 Camera List 

3 PTZ Control Panel 

4 Display Window of Live View 

5 Live View Toolbar 

 

Camera Status: 

 The camera is online and works properly. 

 The camera is in live view. 

 The camera is offline. 

 

Live View Toolbar: 

 

On the Main View page, the following toolbar buttons are available: 

 Set View 
Set the screen layout mode and save the new settings for the 

current view; save the current view as another new view. 

 Stop Live View Stop the live view of all cameras. 
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Resume/Pause 

Auto-switch 
Click to resume/pause the view auto-switch in live view. 

 Show/Hide the Menu Show/Hide the config menu of auto-switch. Click again to hide it. 

  Volume Turn on/off the audio and adjust the audio volume. 

 Full Screen Display the live view in full screen. Press Esc to exit. 

 

Right-click on the display window to open the Live View Management Menu: 

  

 

The following buttons are available on the Live View Management Menu: 

 Stop Live View Stop the live view in the display window. 

 Capture Capture picture in the live view process. 

 Print Snapshot Capture the current picture and then print the picture. 

 
Send Snapshot 

Through Email 

Capture the current picture and then send an Email notification to 

one or more receivers. The captured picture can be attached. 

  Start/Stop Recording Start/Stop the manual recording. 

 
Open Window PTZ 

Control 

Enable PTZ control function on the display window. Click again to 

disable the function. 

 Open Digital Zoom Enable the digital zoom function. Click again to disable the function. 

 
Switch to Instant 

Playback 

Switch to instant playback mode. The record files playback can be 

started from 30s, 1min, 3min, 5min, 8min or 10min before. 

  
Start/Stop Two-way 

Audio 
Click to start the two-way audio function of the camera in live view. 

  Audio On/Mute Click to enable/disable the audio in live view. 

 Camera Status 
Display the status of the camera in live view, including the recording 

status, signal status, connection number, etc. 

 Camera Settings Configure the picture settings, encoding parameters, etc. 

 Full Screen Display the live view in full screen. Click the icon again to exit. 

3.1 Starting and Stopping the Live View 

Starting Live View for Cameras 
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Steps: 

1. Open the Main View page. 

2. Optionally, click the  icon in live view toolbar, then click the screen layout button  and 

select the screen layout mode for the live view. 

3. Click-and-drag the camera on the list to the display window, 

or double-click the camera name after selecting the display window to start the live view. 

Note: You can click-and-drag the video of the camera in live view to another display window if 

needed. 

Starting Live View in Default View Mode 

Purpose: 

The video of the added cameras can be displayed in different view modes. 4 frequently-used default 

view modes are selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen. 

Steps: 

1. Open the Main View page. 

2. Click the icon  to expand the default view list. 

3. Click to select the default view mode, and the video of the added cameras will be displayed in a 

sequence on the screen. 

Note: Right-click the current default view name on the list and click Save View As., and you can save 

the default view as a custom view. 

Starting Live View in Custom View Mode 

Purpose: 

The view mode can also be customized for the video live view. 

Steps: 

1. Open the Main View page. 

2. Click the icon  to expand the custom view list. 

3. Click New View in the custom view list to create a new view. 

4. Input the view name and click Add. The new view is of 4-Screen mode by default. 

5. Optionally, Click the  icon in live view toolbar, then click the screen layout button  and 

select the screen layout mode for the new view. 

6. Click-and-drag the camera to the display window, 

or double-click the camera name to start the live view in the created view. 

7. Click the icon  to save the new view. 

 

Right-click the custom view name on the list, and a menu pops up as follows: 

 

 

The following buttons are available on the right-click menu: 

 Edit View Name Edit the name of the custom view. 

 Delete View Delete the custom view. 
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 Save View Save the new settings of the custom view. 

 Save View As. Save the current view as another custom view. 

 

Stopping the Live View 

Steps: 

1. Select the display window. 

2. Click the icon  that appears in the upper-right corner when the mouse pointer is over the 

display window, 

or click Stop Live View on the right-click menu to stop the live view of the display window. 

You can also click the button  in live view toolbar to stop all the live view. 

3.2 Auto-switch in Live View 

2 types of auto-switch are supported: Single View Auto-switch in default view mode and Multi-view 

Auto-switch in custom view mode. The switching interval is selectable: 20s, 40s, 1min, 3min and 5min. 

Single View Auto-switch 

Purpose: 

The video of all the cameras on the camera list will switch automatically in a selected default view in 

single view auto-switch. 

Steps: 

1. Open the Main View page. 

2. Click the icon  in the toolbar and select the interval time for video switching. 

3. Select a default view and click it to start the live view. 

4. Click the icon  in the toolbar to start the video auto-switch. The icon  turns to . 

5. To pause the video auto-switch, click the icon . 

Multi-view Auto-switch 

Purpose: 

The custom views will switch automatically in multi-view auto-switch. Before proceeding, the custom 

views need to be added to the software. 

Step:  

1. Open the Main View page. 

2. Click the icon  in the toolbar and select the interval time for view switching. 

3. Click the icon  in the toolbar to start the custom view auto-switch. The icon  turns to . 

4. To pause the custom view auto-switch, click the icon . 

3.3 PTZ Control in Live View  

Purpose: 

The software provides PTZ control for cameras with pan/tilt/zoom functionality. You can set the preset, 

patrol and pattern for the cameras on the PTZ Control panel. And you can also open window PTZ 
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control for the operations of PTZ cameras. 

Note: This section only describes the operations of PTZ control. To configure the parameters of PTZ 

control, see Section 9.1.4 PTZ Control. 

Click the icon  to expand the PTZ Control panel. 

 

 

The following buttons are available on the PTZ Control panel: 

 Zoom 

 Focus 

 Iris 

 Auxiliary Focus 

 3D Positioning 

 Light 

 Wiper 

 Lens Initialization 

 

You can click  to start auto scanning; and you can also click the button / , or use the mouse 

wheel to zoom in and out. 

Configuring the Preset 

A preset is a predefined image position which contains information of pan, tilt, focus and other 

parameters. 

Perform the following steps to add a preset: 

1. Click the Preset button to enter the PTZ preset configuration panel. 

2. Click the direction buttons on the PTZ control panel to steer the camera to the desired view. 

3. Select a PTZ preset number from the preset list and click the icon . 

4. Input the name of the preset in the pop-up dialog box. 

5. Click OK to save the settings. 

 

To call a configured preset, double-click the preset, or select the preset and click the icon . 

To modify a preset, select the preset, steer the camera to new view, and click the icon . 
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To delete a preset, select the preset from the list, and click the icon . 

   

 

Configuring the Pattern 

A pattern is a memorized, repeating series of pan, tilt, zoom, and preset functions. 

Perform the following steps to add a pattern: 

1. Click the Pattern button to enter the PTZ pattern configuration panel. 

2. Click  to start recording of this pattern path. 

3. Use the direction buttons to control the PTZ movement. 

4. Click  to stop and save the pattern recording. 

5. Click the icon  to call the pattern. To stop calling the pattern, click . 

Note: Only one pattern can be configured, and the newly-defined pattern will overwrite the previous 

one. 

 

 

Configuring the Patrol 
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A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed 

between two presets and the dwell time at the preset separately programmable. 

Before you start: 

Two or more presets for one PTZ camera need to be added. 

1. Click the Patrol button to enter the PTZ patrol configuration panel. 

2. Select a track number from the drop-down list. 

3. Click  to add a preset, and set the switching interval and patrol speed for the preset. 

4. Repeat the above operation to add other presets to the patrol. 

5. Optionally, you can click  or  to edit or delete the preset in the patrol path. 

6. Click the icon  to call the patrol. To stop calling the patrol, click . 

Notes: 

 Up to 16 patrols can be configured. 

 The switching interval can be set to 1~255 sec, and the patrol speed can be set to level 1~40. 

   

3.4 Manual Recording and Capture 

Toolbar in Each Display Window: 

 
 

In each display window, the following toolbar buttons are available: 

 Capture Capture picture in the live view process. 

  Start/Stop Recording Start/Stop the manual recording. 

 
Switch to Instant 

Playback 
Switch to the instant playback mode.  

 

Manual Recording in Live View 

Manual Recording function allows you to record the live video on the Main View page manually. The 

record files are stored on the pre-allocated HDDs of PCNVR. 

Steps: 
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1. Move the mouse pointer to the display window in live view to show the toolbar. 

2. Click  in the toolbar of the display window or on the right-click Live View Management Menu 

to start recording. The icon  turns to . 

3. Click the icon  to stop the manual recording. 

Note: During the manual or schedule recording, an indicator  appears in the upper-right corner of 

the display window. 

Capturing Picture in Live View 

Steps: 

1. Move the mouse pointer to the display window in live view to show the toolbar. 

2. Click  in the toolbar of the display window or on the right-click Live View Management Menu. 

A small window of the captured picture will be displayed to notify whether the capturing 

operation is done or not.  

Notes: 

 If the picture is captured successfully, there will be a link to the saving path of the captured 

picture; and if not, there will be error messages accordingly. 

 The saving path of the captured picture can be set on the System Configuration interface. For 

more details, see Section 9.2.3 File Saving Path Settings. 

Viewing Captured Pictures 

The pictures captured in live view are stored in the PC running the software. You can view the 

captured pictures if needed. 

Steps: 

1. Click File->Open Captured Picture to open the Captured Picture page. 

2. Select the camera to search from the drop-down list. 

3. Click the icon  to specify the start time and end time for search. 

4. Click Search. The pictures captured between the start time and end time will be displayed. You 

can double-click the picture to enlarge it for a better view. 

 
 

Select the captured picture, and click . You can save a new copy of the selected picture. 
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Select the captured picture, and click . You can delete the selected picture. 

Select the captured picture, and click . You can send an Email notification with the selected picture 

attached. 

3.5 Instant Playback 

Purpose: 

The record files can be played back instantly on the Main View page. Instant playback shows a passage 

of the video which was remarkable, or which was unclear on the first sight. Thus, you can get an 

immediate review if needed. 

Before you start: 

The video files need to be recorded on the pre-allocated HDDs of the PCNVR. 

Steps: 

1. Start the live view and move the mouse pointer to the display window to show the toolbar. 

2. Click the icon  in the toolbar and a list of time periods pops up.  

30s, 1 min, 3 min, 5 min, 8 min, and 10 min are selectable. 

3. Select a time period to start the instant playback. 

Example: If the current time of the live view is 09:30:00, and you select 3 min, then the instant 

playback will start from 09:27:00. 

4. Click the icon  again to stop the instant playback and go back for the live view. 

Notes:  

 During the instant playback, an indicator  appears in the upper-right corner of the display 

window. 

 The live view process will continue after the instant playback completed. 

 

 

Right-click on the display window to open the Instant Playback Management Menu: 
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The following buttons are available on the right-click Instant Playback Management Menu: 

  Pause/Start Pause/Start the instant playback in the display window. 

 Stop Stop the instant playback and return to the live view mode. 

  Speed Up/Down Increase/Decrease the play speed of the instant playback. 

 Single Frame Play back the record file frame by frame. 

 Capture Capture the picture in the instant playback process. 

  Start/Stop Recording Start/Stop clipping the record files. 

  Audio On/Mute Click to turn on/off the audio in instant playback. 

 Live View Switch to live view mode.  

 Full Screen Display the instant playback in full screen. Click the icon again to exit. 

 

3.6 Other Functions in Live View 

There are some other functions supported in live view, including digital zoom, two-way audio, camera 

status and synchronization. 

Auxiliary Screen Preview 

The live video can be displayed on different auxiliary screens for the convenient preview of multiple 

monitoring scenes. Up to 3 auxiliary screens are supported. 

Digital Zoom 

Use the left key of mouse to drag a rectangle area in the lower-right/upper-left direction, and then the 

rectangle area will zoom in/out. 

Two-way Audio 

Two-way audio function enables the voice talk of the camera. You can get not only the live video but 

also the real-time audio from the camera. This two-way audio can be used for only one camera at one 

time. 

Camera Status 

The camera status, such as recording status, signal status, connection number, etc., can be detected 

and displayed for check. The status information refreshes every 10 seconds.  
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Camera Settings 

The parameters of camera settings, including picture settings, encoding parameters, etc., can be 

configured. 
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Chapter 4 Playback 

Purpose: 

The record files stored on the pre-allocated HDDs of PCNVR can be searched and played back. Thus, 

you can get a review of the monitoring scenario. 

Before you start: 

The video of the cameras is required to be recorded for playback.  

Click the Playback tab, 

or click View->Playback to open the Playback page. 

 
 

Playback Page 

1 Camera List, View List, Event List 

2 Calendar 

3 Search Options 

4 Playback Tab and File List Tab 

5 Display Window of Playback 

6 Playback Toolbar 

7 Timeline 

 

Right-click on the display window to open the Playback Management Menu: 

 

 

The following buttons are available on the Playback Management Menu: 
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 Stop Playback Stop the playback in the display window. 

  Start/Stop Recording Start/Stop clipping the record files. 

 Capture Capture picture in the playback process. 

 Open Digital Zoom Enable the digital zoom. Click again to disable the function. 

-- Accurate Positioning Play back the record files from an accurately specified time. 

  Audio On/Mute Click to turn on/off the audio in playback. 

 Full Screen Display the playback in full screen. Click the icon again to exit. 

 

4.1 Normal Playback 

Purpose: 

The record files can be searched by the camera or the custom view for Normal Playback. 

Searching Record Files for Normal Playback 

Steps: 

1. Open the Playback page. 

2. Click  to expand the Camera List or View List on the left-side. 

3. Select the cameras or views to be searched from the list. 

4. Select the day for search on the calendar. 

You can also click  to show more search options, click the icon  to specify the start time 

and end time, and select the file type for the search. 

5. Click Search. The record files of selected cameras or views will be displayed on File List tab page.  

You can check the information including the camera source, start time, end time, recording type, file 

size and status of the record files. Use the filter field to locate desired record files, or click on the 

headings to list the record files in the desired order. 

Note: If there are record files for that camera in that day, on the calendar, the icon for that day is 

displayed as . Otherwise it is displayed as . 
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Normal Playback 

After searching the record files for the normal playback, you can play back the record files in the 

following two ways: 

 Playback by File List 

click the icon , or double-click the record file in the file list to display the video on the 

Playback tab page. 

 Playback by Timeline 

The timeline indicates the time duration for the record file, and the record files of different types 

are color coded. Click the Playback tab to go to the Playback tab page, and click on the timeline 

to play back the video from the specific time. 

You can click  or  to scale up or scale down the timeline bar. 

You can click  or  to go to the previous or the next time period. 

You can use the mouse wheel to zoom in or zoom out on the timeline. 

 

 

Normal Playback Toolbar: 

 

On the Playback page, the following toolbar buttons are available: 

  Async/Sync Playback Click to play back the record files synchronously/asynchronously. 

 Stop All Stop the playback of all cameras. 

  Pause/Play Pause/Resume the playback of record files. 

 Single Frame Play back the record files frame by frame. 

  Volume Click to turn on/off the audio and adjust the audio volume. 

 Full Screen Display the video playback in full screen. Press Esc to exit.. 

 Backup Download the video clips to the local PC for backup. 

 

Note: You can move the slider on the Playback Speed Bar to set the playback speed. 
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4.2 Event Playback 

Purpose: 

The recordings triggered by motion detection and alarm input can be searched for Event Playback. 

Searching Record Files for Event Playback 

Steps: 

1. Open the Playback page. 

2. Click  to expand the Event List on the left-side. 

3. Click Motion Detection or Alarm Input, and select the cameras or alarm input sensors. 

4. Select the day for search on the calendar. 

You can also click  to show more search options, click the icon  to specify the start time 

and end time for the search. 

5. Click Search. The recordings from the selected cameras and sensors triggered by motion 

detection or alarm input will be displayed on the File List tab page.  

You can check the time, event type, event source and other information of the record files. Use the 

filter field to locate desired record files, or click on the headings to list the record files in the desired 

order. 

 

 

Event Playback 

After searching the record files for the event playback, you can play back the record files in the 

following two ways: 

 Playback by File List 

click the icon , or double-click the record file in the file list to display the event linkage video 

on the Playback tab page. 

 Playback by Timeline 

The timeline indicates the time duration for the record file. Click the Playback tab to go to the 

Playback tab page, and click on the timeline to play back the video from the specific time. 
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You can click  or  to scale up or scale down the timeline bar. 

You can click  or  to go to the previous or the next time period. 

You can use the mouse wheel to zoom in or zoom out on the timeline. 

 

 

Event Playback Toolbar: 

 

On the Playback page, the following toolbar buttons are available: 

 Stop Playback Stop the event playback. 

  Previous/Next Event Go to the playback of the previous/next event. 

  Pause/Play Pause/Resume the playback of record files. 

 Single Frame Play back the record files frame by frame. 

  Volume Click to turn on/off the audio and adjust the audio volume. 

 Full Screen Display the playback of the video in full screen. Press Esc to exit. 

 Backup Download the video clips to the local PC for backup. 

 

You can move the slider on the Playback Speed Bar to set the playback speed. 

4.3 Synchronous Playback 

Purpose: 

In synchronous playback, the record files can be played back in synchronization. 

Note: Record files from up to 16 cameras can be played back simultaneously. 

Synchronous Playback for Some Searched Cameras 

Steps: 

1. Start normal playback of the searched cameras.  

2. Click  in the toolbar, and then the record files in normal playback will be played in sync. The 

icon  turns to . 
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3. To disable the synchronous playback, click the icon . 

Synchronous Playback for All Searched Cameras 

Steps: 

1. Search the record files for the normal playback and Click Playback tab to go to Playback tab page. 

2. Click  in the toolbar to enable the synchronous playback. The icon  turns to . 

3. Click on a specific time point of the timeline to start the synchronous playback for all searched 

cameras. 

4. To disable the synchronous playback, click the icon . 

 

 

4.4 Local Playback 

Purpose: 

The video files recorded on PCNVR can be exported to the local PC for backup. You can search and 

view the video clips in local playback. 

Steps: 

1. Click File->Open Video File to open the player for video clips playback. 

2. Click the icon , and select file from the saving path of the video files for local playback. 
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The following buttons are available on the local playback page: 

  CIF/4CIF Display the video in cif/4cif resolution. 

 Full Screen Display the local playback page in full screen. 

 Close Close the local playback page. 

  Pause/Play Pause/Resume the playback of the record files. 

 Stop Stop the playback of the record files. 

 Speed Down Decrease the play speed of local playback. 

 Speed Up Increase the play speed of local playback. 

 Single Frame Play back the record files frame by frame. 

 Digital Zoom Enable the digital zoom function. Click again to disable it. 

  Mute/Audio On Turn off/on the audio in the local playback. 

 Capture Capture the picture in the local playback process. 

 Open File Select the file from local path for playback. 
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Chapter 5 Record Files Backup 

Purpose: 

The video files recorded by PCNVR are stored on the pre-allocated HDDs of PC. And the video files can 

be exported for backup. The saving path of the exported video files can be set. For details, see Section 

9.2.3 File Saving Path Settings.  

Note: The backup video files will be saved to the default location if no specified saving path has been 

set. The default location is: C:\ivms4200\video. 

5.1 Exporting Record Files 

Steps: 

1. Search the record files on the Playback page.  

2. Check the checkboxes to select the record files for backup. 

3. Click Export Video File to export the selected video files to the saving path you configured. The 

icon  turns to  in the downloading process, and the record file status changes from 

Waiting to Download Completed after the downloading process finished. 

 

5.2 Exporting Video Clips 

Purpose: 

The recorded video files can be clipped and the video clips can also be exported for backup. 

Exporting Video Clips by Timeline 

Steps: 

1. Start the normal playback or event playback. 

2. Click-and-drag the mouse to select a segment video file on the timeline. 
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3. Click  in the playback toolbar to enter the Recordings Backup interface. You can check the 

camera source, start time, end time and status of the video clips. 

4. Check the checkboxes to select the video clips for backup. 

5. Optionally, you can click Delete to delete the selected video clips and use the filter field to locate 

desired video clips. 

6. Click Start Recording Backup to download the selected video clips.  

You can click Stop Recording Backup to stop downloading in the downloading process. 

7. The status of video clips changes from Waiting to Download Completed after the downloading 

process finished. Click Cancel to exit. 

 
 

Exporting Video Clips by Manual Recording 

Steps: 

1. Start the normal playback or event playback. 

2. Move the mouse pointer to the display window in playback to show the toolbar. 

3. Click  in the toolbar of the display window or on the right-click Playback Management Menu 

to start clipping. The icon  turns to . 

4. Click the icon  to stop clipping. A prompt box with the saving path of the video clips will pop 

up if all the operations succeed.  

 

  



User Manual of Hikvision iVMS-4200 PCNVR V1.03  

39 
 

Chapter 6 Event Management and Alarm I/O 

Settings 

Purpose: 

In PCNVR, rules can be set up for triggers and linkage actions. You can assign linkage actions to the 

trigger by setting up a rule. For example, when motion is detected, an audible warning appears or 

other linkage actions happen. 

Click the  icon on the Configuration panel, 

or click Tool->Event Management to open the Event Management page. 

 
 

You can set different linkage actions for the following triggers: 

 Alarm Input 

 Motion Detection 

 Tampering Alarm 

 PIR Alarm 

 Video Loss 

 PIR Alarm 

 Wireless Alarm 

 Emergency Alarm 

 Exception 

 

Different linkage actions can be set for the triggers: 

Table 6.1 Descriptions of Linkage Actions 

Linkage Actions Descriptions 

Audible Warning The software gives an audible warning when alarm is triggered. 

Notify Surveillance Center Notify the surveillance center of the alarm information. 

Upload Picture to FTP Upload the alarm picture to the FTP. 
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Email Linkage Send an Email notification to one or more receivers. 

Alarm Output 
Enable the alarm output function. Select the alarm output port and the 

external device connected to the port can be controlled. 

Alarm Triggered Record Start the recording of the selected cameras when alarm is triggered. 

PTZ Linkage Trigger a PTZ linkage action, including the preset, patrol or pattern. 

Wireless Acousto-optic 

Alarm 

Trigger the wireless acousto-optic alarm. 

(only available for PIR/Wireless/Emergency Alarm) 

 

Select the event from the list and click Modify/Delete. Then you can add/delete the event source and 

its linkage actions. 

6.1 Configuring Alarm I/O Settings 

External devices such as smoke detectors and doorbells can be connected to the alarm inputs of 

cameras and used for triggering alarms or recordings. And an alarm output’s main function is to 

trigger external devices such as an alarm siren, a door control relay, etc. 

6.1.1 Manually Turning On/Off Alarm Output 

Purpose: 

Alarm output function can be enabled or disabled by turning on or off the corresponding alarm output 

channel manually. 

Steps: 

1. Click Tool->I/O Control to open the I/O Control page.  

You can check the device output name, IP address and alarm output status on the list. 

2. Click Off/On to turn on/off the alarm output channel manually. 

3. Click Close to close the page. 

 

6.1.2 Configuring Alarm I/O Parameters 

Purpose: 
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The alarm I/O parameters including input/output name, input status, output delay time, output 

schedule, etc., can be configured. 

Click the  icon on the Configuration panel, 

or click Tool->I/O Settings to open the I/O Settings Management page. 

 
Steps: 

1. Select an alarm input/output channel and click Edit, 

or double-click the input/output channel to enter the Modify I/O Alarm interface. 

2. Edit the alarm information if required. 

Alarm Type: Alarm Input or Alarm Output. 

IP Address: IP address of the alarm input/output device. 

I/O Number: Alarm input/output No. of the channel. 

Alarm Name: Descriptive name of the alarm input/output. You can edit the name as you want. 

Status: Set the status as Normal Open or Normal Closed according to the alarm input device. 

Output Delay: Output delay time. You can select the delay time from the drop-down list. 

Schedule: Arming schedule of alarm output. You can edit the template if needed.  

3. Optionally, click Copy to… to copy the settings to other alarm input/output channels. 

4. Click OK to save the settings. 
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6.1.3 Configuring Alarm Input Linkage 

Purpose: 

When a device's alarm input port receives a signal from an external alarm device, such as smoke 

detector, doorbell, etc., the alarm input linkage actions are triggered for notification. 

Steps: 

1. Open the Event Management page and Click  to expand the alarm input list. 

2. Select an alarm input channel and click Modify, 

or double-click the channel to enter the Modify Event interface. 

3. Select the event source from the drop-down list if you want to change the current one. 

4. Select the arming schedule template from the drop-down list. 

All-day Template: for all-day continuous arming. 

Weekday Template: for working-hours continuous arming from 8:00 AM to 8:00 PM. 

Template 01-09: fixed templates for specific schedules. You can edit the templates if needed. 

Custom: can be customized as desired. 

If you need to edit or customize the template, click Edit to enter the Templates Management 

interface. For details, see Configuring Arming Schedule Template. 

5. Check the checkboxes to activate the linkage actions. For details, see Table 6.1 Descriptions of 

Linkage Actions. 

6. Optionally, click Copy to… to copy the alarm parameters to other channels. 

7. Click Confirm to save the settings. 

 
 

Configuring Arming Schedule Template 

Perform the following steps to configure the arming schedule template to be applied: 

If Template 01-09 is selected, start from step 1; 

If Custom is selected, start from step 2. 

1. Click Edit. You can edit the template name. 

2. Set the time schedule for the selected template. 

When the cursor turns to , you can edit the schedule time bar. 
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When the cursor turns to , you can move the selected time bar you just edited. 

When the cursor turns to , you can lengthen or shorten the selected time bar. 

3. Optionally, you can select the schedule time bar,  

and then click the icon  to delete the selected time bar, 

or click the icon  to delete all the time bars, 

or click the icon  to copy the time bar settings to the other dates. 

4. Click Save to save the new settings. 

Note: Up to 8 time periods can be set for each day in the arming schedule. 

 
 

6.2 Configuring Motion Detection Alarm 

Purpose: 

A motion detection alarm is triggered when the software detects motion within its defined area. The 

linkage actions, such as alarm output, alarm triggered record, etc., can be set. 

Steps: 

1. Open the Event Management page and Click  to expand the motion detection list. 

2. Select a motion detection channel and click Modify, 

or double-click the channel to enter the Modify Event interface. 

3. Select the event source from the drop-down list if you want to change the current one. 

4. Click Area Settings to open the Detection Area Settings page. 

5. Click-and-drag the mouse to draw a defined area for motion detection. 

You can click the icon  to set the whole video area as the detection area, click the icon  to 

delete the selected area, or click the icon  to clear all the detection areas. 

6. Drag the slider on the sensitivity bar to adjust the motion detection sensitivity. The larger the 

value is, the more sensitive the detection is.  

7. Select the arming schedule template from the drop-down list. 

If you need to edit or customize the template, click Edit to enter the Templates Management 

interface. For details, see Configuring Arming Schedule Template. 

8. Check the checkboxes to activate the linkage actions. For details, see Table 6.1 Descriptions of 

Linkage Actions. 

9. Optionally, click Copy to… to copy the event parameters to other channels. 

10. Click Confirm to save the settings. 
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6.3 Configuring Tampering Alarm 

Purpose: 

A tampering alarm is triggered when the camera is covered and the monitoring area cannot be viewed. 

The linkage actions, such as alarm output, alarm triggered record, etc., can be set. 

Steps: 

1. Open the Event Management page and Click  to expand the tampering alarm list. 

2. Select a tampering alarm channel and click Modify, 

or double-click the channel to enter the Modify Event interface. 

3. Select the event source from the drop-down list if you want to change the current one. 

4. Click Area Settings to open the Tamper-proof Area Settings page. 

5. Click-and-drag the mouse to draw a defined area for tampering detection. 

You can click the icon  to set the whole video area as the tamper-proof area, or click the icon

 to delete the area. 

6. Drag the slider on the sensitivity bar to adjust the tamper-proof sensitivity.  

7. Select the arming schedule template from the drop-down list. 

If you need to edit or customize the template, click Edit to enter the Templates Management 

interface. For details, see Configuring Arming Schedule Template. 

8. Check the checkboxes to activate the linkage actions. For details, see Table 6.1 Descriptions of 

Linkage Actions. 

9. Optionally, click Copy to… to copy the event parameters to other channels. 

10. Click Confirm to save the settings. 
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6.4 Configuring Video Loss Alarm 

Purpose: 

When PCNVR cannot receive video signal from the devices, the video loss alarm will be triggered. The 

linkage actions, such as alarm output, alarm triggered record, etc., can be set. 

Steps: 

1. Open the Event Management page and Click  to expand the video loss alarm list. 

2. Select a video loss channel and click Modify, 

or double-click the channel to enter the Modify Event interface. 

3. Select the event source from the drop-down list if you want to change the current one. 

4. Select the arming schedule template from the drop-down list. 

If you need to edit or customize the template, click Edit to enter the Templates Management 

interface. For details, see Configuring Arming Schedule Template. 

5. Check the checkboxes to activate the linkage actions. For details, see Table 6.1 Descriptions of 

Linkage Actions. 

6. Optionally, click Copy to… to copy the event parameters to other channels. 

7. Click Confirm to save the settings. 
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6.5 Configuring PIR Alarm 

Purpose: 

A PIR (Passive Infrared) alarm is triggered when an intruder moves within the detector's field of view. 

The heat energy dissipated by a person, or any other warm blooded creature such as dogs, cats, etc., 

can be detected. 

Note: The PIR Alarm function requires the support of connected device. 

Steps: 

1. Open the Event Management page and Click  to expand the PIR alarm list. 

2. Select a PIR alarm channel and click Modify, 

or double-click the channel to enter the Modify Event interface. 

3. Select the event source from the drop-down list if you want to change the current one. 

4. Input a descriptive name of the alarm. 

5. Check the checkboxes to activate the linkage actions. For details, see Table 6.1 Descriptions of 

Linkage Actions. 

6. Optionally, click Copy to… to copy the event parameters to other channels. 

7. Click Confirm to save the settings. 
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6.6 Configuring Wireless Alarm 

Steps: 

1. Open the Event Management page and Click  to expand the wireless alarm list. 

2. Select a wireless alarm channel and click Modify, 

or double-click the channel to enter the Modify Event interface. 

3. Select the event source from the drop-down list if you want to change the current one. 

4. Check the checkbox Enable to enable the wireless alarm function. 

5. Select the alarm input channel from the drop-down list. 

6. Input a descriptive name of the alarm. 

7. Check the checkboxes to activate the linkage actions. For details, see Table 6.1 Descriptions of 

Linkage Actions. 

8. Optionally, click Copy to… to copy the event parameters to other channels. 

9. Click Confirm to save the settings. 

 
 

6.7 Configuring Emergency Alarm 

Steps: 

1. Open the Event Management page and Click  to expand the emergency alarm list. 

2. Select an emergency alarm channel and click Modify, 

or double-click the channel to enter the Modify Event interface. 

3. Select the event source from the drop-down list if you want to change the current one. 

4. Check the checkboxes to activate the linkage actions. For details, see Table 6.1 Descriptions of 

Linkage Actions. 

5. Optionally, click Copy to… to copy the event parameters to other channels. 

6. Click Confirm to save the settings. 
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6.8 Configuring Exception Linkage 

Steps: 

1. Open the Event Management page and Click  to expand the exception list. 

HDD Full: The HDD is full. 

HDD Exception: Writing HDD error or unformatted HDD. 

Network Disconnected: The network is disconnected. 

Illegal Login: Incorrect user name or password. 

Video Standard Mismatch: The configured video input standard mismatches with the video 

output of the camera. 

Video Exception: The video signal is abnormal. 

2. Select an exception type and click Modify, 

or double-click the exception type to enter the Modify Event interface. 

3. Select the event source from the drop-down list if you want to change the current one. 

4. Check the checkboxes to activate the linkage actions. For details, see Table 6.1 Descriptions of 

Linkage Actions. 

5. Optionally, click Copy to… to copy the event parameters to other types of exceptions. 

6. Click Confirm to save the settings. 
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6.9 Viewing Alarm and Event Information 

The information of recent alarms and events can be displayed. Click the icon  in Alarms and Events 

Toolbar to show the Alarms and Events panel. 

 

 

On the Alarms and Events panel, the following toolbar buttons are available: 

 Clear Info Clear the information of alarms and events displayed in the list. 

  
Enable/Disable Alarm 

Triggered Pop-up Image 
Click to enable/disable image pop-up when alarms occur. 

  Enable/Disable Audio Click to turn on/off the audio warning when alarms occur. 

  Auto Hide/Lock Click to hide automatically/lock the Alarms and Events panel. 

 Maximize Maximize the Alarms and Events panel in a new tab page. 

  Show/Hide Click to show/hide the Alarms and Events panel. 

 

Viewing Alarms Information 

Different alarm types can be displayed on the panel: Motion Detection, Video Exception, Alarm Input, 

Device Exception and Other Alarm. You can check the checkbox to enable the displaying of that type 

alarm. 

Before you start: 

To display the alarms, the event parameters need to be configured.  

Steps: 

1. Click the Alarm tab. 

2. Check the checkboxes of different alarm types. 
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3. When an alarm occurs, the icon  twinkles to call attention. The alarm information, including 

the time, details and content will be displayed.  

Click  to get a live view of the alarm triggered camera. 

Click  to send an Email notification of the alarm to one or more receivers. 

4. Click the icon , and then the alarm picture will pop up when the events occur. To disable the 

function, click . 

5. To clear the alarm information, click the icon , or right-click on an alarm log and then click 

Clear. 

Viewing Events Information 

The abnormal events of the software, such as the email sending failure, device disconnection, can also 

be displayed and viewed on the panel. 

Steps: 

1. Click the Event tab.  

The event information, including the time and detailed description will be displayed. 

2. To clear the event information, click the icon , or right-click on an event log and then click 

Clear. 
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Chapter 7 E-map Management 

Purpose: 

The E-map function gives a visual overview of the locations and distributions of the installed cameras 

and alarm input devices. You can get the live view of the cameras on the map, and when alarm is 

triggered, you will get a notification message from the map. 

Click the E-map tab, 

or click View->E-map to open the E-map page. 

 
 

7.1 Adding an E-map 

Purpose: 

An E-map needs to be added as the main map for the hot spots and hot regions. 

Steps: 

1. Open the E-map page. 

2. Click the icon  on the page to open the map adding dialog box. 

3. Input a descriptive name of the added map as desired. 

4. Click the icon  and select a map file from the local path. You can get a preview of the map. 

5. Click OK to save the settings. 

Notes:  

 Only one map can be added as the main map. 

 The format of the map file can only be *.png, *.jpg or *.bmp. 
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The map added is displayed in the Map Display Area. Use the mouse wheel to zoom in or zoom out on 

the map. You can click-and-drag the yellow window in the lower-right corner or use the direction 

buttons and zoom bar to adjust the map area for view. 

To modify the map information, click the Modify button in the Map Navigation Column. 

To delete the map, click the Delete button in the Map Navigation Column. 

 

 

Click the button Edit Map or Map Preview in Map Navigation Column to enter the map editing mode 

or map preview mode. 

E-map Toolbar in Map Editing Mode: 

 

E-map Toolbar in Map Preview Mode: 

 

On the E-map page, the following toolbar buttons are available: 

 Add Camera Add a camera as the hot spot on the map. 
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 Add Alarm Input Add an alarm input sensor as the hot spot on the map. 

 Add Hot Region Add a sub-map as the hot region on the main map. 

 Delete Remove the hot spots or hot regions from the map. 

 Previous Go to the previous map. 

 Next Go to the next map. 

 Clear Alarm Info. Clear the alarm information displayed on the map. 

 

7.2 The Hot Spot Function 

Purpose: 

The cameras and alarm inputs can be added on the map and are called the hot spots. The hot spots 

show the locations of the cameras and alarm inputs, and you can also get the live view and alarm 

information of the surveillance scenarios through the hot spots. 

7.2.1 Adding Hot Spots 

Adding Cameras as Hot Spots 

Steps: 

1. Click the Edit Map button in the Map Navigation Column to enter the map editing mode. 

2. Click the icon  in the toolbar to open the Add Hot Spot dialog box. 

3. Check the checkboxes to select the cameras to be added. 

4. Optionally, you can edit hot spot name, select the name color and select the hot spot icon. 

5. Click OK to save the settings. The camera icons are added on the map as hot spots and the icons 

of the added cameras changes from  to  in the camera list. You can click-and-drag the 

camera icons to move the hot spots to the desired locations. 

You can also click-and-drag the camera icons from the camera list to the map directly to add the 

hot spot. 
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Adding Alarm Inputs as Hot Spots 

Steps: 

1. Click the Edit Map button to enter the map editing mode. 

2. Click the icon  in the toolbar to open the Add Hot Spot dialog box. 

3. Check the checkboxes to select the alarm inputs to be added. 

4. Optionally, you can edit hot spot name, select the name color and select the hot spot icon. 

5. Click OK to save the settings. The alarm input icons are added on the map as hot spots and the 

icons of the added alarm inputs changes from  to  in the alarm input list. You can 

click-and-drag the alarm input icons to move the hot spots to the desired locations. 

You can also click-and-drag the alarm input icons from the alarm input list to the map directly to 

add the hot spot. 

 

 

7.2.2 Modifying Hot Spots 

Purpose: 

You can modify the information of the added hot spots on the map, including the name, the color, the 

icon, etc. 

Steps: 

1. Click the Edit Map button to enter the map editing mode. 

2. Select the hot spot icon on the map to show the hot spot modifying page. 

3. You can edit the hot spot name in the text field and select the color, the icon and the linked 

camera or alarm input from the drop-down list. 

4. Optionally, you can click the icon /  on the right side of Map Display Area to hide/show the 

hot spot modifying page. 

5. To delete the hot spot, select the hot spot icon and click  in the toolbar; or right-click the hot 

spot icon and click Delete. 
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7.2.3 Previewing Hot Spots 

Steps: 

1. Click the Map Preview button in the Map Navigation Column to enter the map preview mode. 

2. Double-click the camera hot spots, and you can get the live view of the cameras. 

3. If there is any alarm triggered, the icon  will appear and twinkle near the hot spot. Click the 

alarm icon, and then you can check the alarm information, including alarm type and triggering 

time. You can click the icon  in the toolbar to clear the alarm information. 

 

7.3 The Hot Region Function 

Purpose: 

The hot region function links a map to another map. When you add a map to the main map as a hot 

region, an icon of the link to the added map is shown on the main map. The added map is called child 
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map while the main map to which you add the hot region is the parent map. 

Before you start: 

The main map needs to be added as the parent map before you add any sub-maps. 

7.3.1 Adding Hot Regions 

Steps: 

1. Click the Edit Map button to enter the map editing mode. 

2. Click the Add button in the Map Navigation Column to add the sub-maps.  

3. Select the main map name on the list and click the icon  in the toolbar to open the Add Hot 

Region dialog box. 

4. Check the checkboxes to select the sub-maps to be linked. 

5. Optionally, you can edit the hot region name, and select the hot region color and icon. 

6. Click OK to save the settings. The sub-map icons are added on the main map as the hot regions. 

Click-and-drag the sub-map icons to move the hot regions to the desired locations.  

You can also click-and-drag the sub-map icons from the map list to the main map directly to add 

the hot region. 

Note: Up to 16 sub-maps can be added under the main map. 

   

 

7.3.2 Modifying Hot Regions 

Purpose: 

You can modify the information of the hot regions on the main map, including the name, the color, the 

icon, etc. 

Steps: 

1. Click the Edit Map button to enter the map editing mode. 

2. Select the hot region icon on the main map to show the hot region modifying page. 

3. You can edit the hot region name in the text field and select the color, the icon and the linked 
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sub-map from the drop-down list. 

4. Optionally, you can click the icon /  on the right side of Map Display Area to hide/show the 

hot region modifying page. 

5. To delete the hot region, select the hot region icon and click  in the toolbar; or right-click the 

hot spot icon and click Delete. 

 
 

7.3.3 Previewing Hot Regions 

Steps: 

1. Click the Map Preview button to enter the map preview mode. 

2. Double-click the hot region icon to enter the linked sub-map. 

3. The hot spots can also be added on the hot regions. 

4. You can click the icon /  in the toolbar to go the previous/next map.  
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Chapter 8 Log Management 

Purpose: 

The log files record the activities of PCNVR and can be searched by different ways. You can view the 

detailed information of the activities, such as the operation time, the type, the local operator, etc. And 

you can also export the log files to local PC for backup if needed. 

Click Tool->Log Search to open the Log Search page. 

 
 

8.1 Searching Log Files 

There are 4 types of search modes supported: All, By Type, By time and By Type&Time. 

Searching All Log Files 

Steps: 

1. Select All from the drop-down list as the search mode.  

2. Click Search. All the log files of PCNVR will be displayed on the list. 

Searching Log Files By Type 

Steps: 

1. Select By Type from the drop-down list as the search mode. 

2. Select the log type for search. 5 log types are selectable: All, Alarm, Exception, Operation and 

Information. 

3. Select the minor type of the logs to narrow the search range. 

4. Click Search. The log files of the selected types will be displayed on the list. 

Searching Log Files By Time 

1. Select By Time from the drop-down list as the search mode. 
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2. Click the icon  to specify the start time and end time for search. 

3. Click Search. The log files of which the operation time is between the start time and end time will 

be displayed on the list. 

Searching Log Files By Type&Time 

1. Select By Type&Time from the drop-down list as the search mode. 

2. Select the log type and minor type. 

3. Click the icon  to specify the start time and end time for search. 

4. Click Search. The search results will be displayed on the list. 

8.2 Exporting Log Files for Backup 

Before you start: 

Search out the log files for backup. 

Steps: 

1. Select the log file from the list. 

2. Click Backup to open the Log Backup dialog box. 

3. Click the icon  and select a local saving path for log file backup. 

4. Click Backup to start the backup process. 

   

 

8.3 Viewing Log File Backup 

Purpose: 

The log files exported for backup are stored on the local PC, and you can view the detailed information 

of the logs. 

Steps: 

1. Click File->Open Log File to open the Log File page. 

2. Click the icon  to select the log file backup from the local PC. And then the information of the 
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logs, such as operation time, type, operator, etc., will be displayed on the list. 
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Chapter 9 Camera Settings and System 

Configuration 

9.1 Camera Settings 

Purpose: 

The picture settings, encoding parameters, on screen display(OSD) settings, PTZ control parameters, 

etc., can be configured. 

Click the  icon on the Configuration panel, 

or click Tool->Camera Settings to open the Camera Settings page. 

 
 

9.1.1 Picture Settings 

Purpose: 

The picture parameters, such as brightness, contrast, saturation, etc., can be configured to acquire 

high image quality for better view. 

Steps: 

1. Open the Camera Settings page and click  to enter the Picture Settings interface. 

2. Select the camera from the drop-down list on the left-side of the page. 

3. Move the slider on the parameter bar to adjust the value of the parameter. 

4. Click Default, and you can restore the default values of the parameters. 

5. Click Advanced Settings, and you can configure more picture parameters. 

6. Click Confirm to save the settings. 



User Manual of Hikvision iVMS-4200 PCNVR V1.03  

62 
 

 

 

9.1.2 Video&Audio Parameters 

Purpose: 

You can configure the encoding parameters of main stream and sub-stream, and other settings of the 

camera. 

Steps: 

1. Open the Camera Settings page and click  to enter the Video&Audio Parameters interface. 

2. Select the camera from the drop-down list on the left-side of the page. 

3. Click the Main Stream/Sub Stream tab, and you can configure the encoding parameters, such as 

the resolution, stream type, frame rate, picture quality, etc.  

Click the Other Settings tab, and you can set the alarm input type and adjust the audio volume. 

4. Click Confirm to save the settings. 

 

 

9.1.3 Video Display 

Purpose: 

You can configure on screen display(OSD) settings and the privacy mask can be defined on the screen 

to protect the individual privacy if needed.  

Steps: 
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1. Open the Camera Settings page and click  to enter the Video Display interface. 

2. Select the camera from the drop-down list on the left-side of the page. 

3. Edit the camera name in the text field. 

4. Check the checkbox to enable the camera name display, date display and week display. You can 

also set the format of the date and time. 

5. Select the OSD attribute from the drop-down list.  

4 types of OSD attributes are selectable: Transparent And Flash, Transparent And Not Flash, Flash 

And Not Transparent, Not Flash And Not Transparent . 

6. Check the checkbox Enable Privacy Mask to enable the privacy mask function. 

Perform the following steps to draw a privacy mask: 

1) Select Draw Privacy Mask Area from the drop-down list under the live video window. 

2) Click-and-drag the mouse on the live video to draw a rectangle area as the privacy mask. 

3) Adjust the size of the privacy mask and move it to the desired location. 

You can click the icon  to remove the selected privacy mask from the screen. 

You can click the icon  to remove all the privacy masks from the screen. 

7. Edit the text overlay on the screen. 

Perform the following steps to edit and display the text overlay on the screen: 

1) Check the checkbox in the Text Overlay field. 

2) Click on the text field, and you can edit the content of the overlay. 

3) Move the text overlay to the desired location on the screen. 

8. Click Confirm to save the settings. 

Note: Up to 4 privacy masks can be defined for each camera. 

   
 

9.1.4 PTZ Control  

Purpose: 

The PTZ parameters should be consistent with the settings of the camera side to ensure valid PTZ 
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control. 

Step: 

1. Open the Camera Settings page and click  to enter the PTZ Control interface. 

2. Select the camera from the drop-down list on the left-side of the page. 

3. Select the PTZ parameters, such as baud rate, data bit, stop bit, etc., from the drop-down list. 

4. Optionally, you can click Test, and do some PTZ operations to test the parameters. 

5. Click Confirm to save the settings. 

 

 

9.2 System Configuration 

Purpose: 

The general parameters, file saving paths, keyboard and joystick shortcuts, alarm sounds and other 

system settings of PCNVR can be configured. 

Click the  icon on the Configuration panel, 

or click Tool->System Configuration to open the System Configuration page.  

 
 



User Manual of Hikvision iVMS-4200 PCNVR V1.03  

65 
 

9.2.1 System Information 

Steps: 

1. Open the System Configuration page. 

2. Click the System Information tab. You can view the system information of PCNVR. For details, see 

Table 9.1 Descriptions of System Information. 

 

 

Table 9.1 Descriptions of System Information 

System Information Descriptions 

Software Version The version information of the software (read-only). 

Serial No. The serial No. of PCNVR (read-only). 

Record Disk Number The number of local PC disks which are available for PCNVR (read-only). 

Disk Overwrite Whether the video files recorded on the disk can be overwritten.  

 

9.2.2 General Parameters 

1. Open the System Configuration page. 

2. Click the General tab to enter the General Parameters interface. 

3. Configure the general parameters of the software. For details, see Table 9.2 General Parameters. 

4. Click Confirm to save the settings. 

 

 

Parameters Descriptions 

View Scale 
The view scale of the video in live view or playback. It can be set as Full 

Screen, 4:3, 16:9 or Original Resolution. 

Network Performance The current network conditions. It can be set as Bad, Normal, Better or Best. 

Play Performance The play performance of live video. It can be set as Low, Medium or High. 

Enable Screen Toolbar Show the toolbar on each display window in live view or playback. 
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Display 

Enable Auto-login Log in the software automatically. 

Resume Live View 

Status 

Resume the latest live view status after you log in the software again. 

Auto-change Stream 

Type 

Change the stream type automatically in live view according to the size of 

the display window.  

 

9.2.3 File Saving Path Settings 

Purpose: 

The video files backup, the captured pictures and the system configuration files are stored on the local 

PC. The saving paths of these files can be configured. 

Steps: 

1. Open the System Configuration page. 

2. Click the Path tab to enter the File Saving Path Settings interface. 

3. Click the icon  and select a local path for the files. 

4. Click Confirm to save the settings. 

 
 

9.2.4 Network Settings 

General Settings 

Steps: 

1. Open the System Configuration page. 

2. Click the Network Settings->General tab to enter the General Network Settings interface. 

3. Configure the general network parameters of PCNVR, such as device port, subnet mask, alarm 

host IP, etc. 

4. Click Confirm, and reboot the PCNVR to activate the new settings. 
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DDNS Settings 

You can use the DDNS method to avoid the complexity of accessing by the dynamic IP address. 

Steps: 

1. Open the System Configuration page. 

2. Click the Network Settings->DDNS tab to enter the DDNS Settings interface. 

3. Check the checkbox Enable DDNS to enable the DDNS function. 

4. Select the protocol type from the drop-down list. 

5. Input the required information, such as protocol type, server address, etc. 

6. Click Apply to save the settings. 

 

 

 

NTP Settings 

You can configure the NTP server to synchronize the system time at a certain time interval. 
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Steps: 

1. Open the System Configuration page. 

2. Click the Network Settings->NTP tab to enter the NTP Settings interface. 

3. Check the checkbox Enable NTP to enable the NTP function. 

4. Input the required information. 

Server Address: Input the NTP server address for time synchronization. 

NTP Port: Input the port number of NTP service. The default value is 123. 

Synchronization Interval: Set the interval time for synchronization. 

Time Zone: Select the time zone from the drop-down list. 

5. Click Confirm to save the settings. 

 

 

9.2.5 Keyboard and Joystick Shortcuts Settings 

Purpose: 

DS-1003 keyboard can be connected to PCNVR and be used to control the PTZ cameras. You can set 

the shortcuts of PC keyboard and USB joystick to get quick and convenient access to the commonly 

used actions. 

Steps: 

1. Select the COM port from the drop-down list if 1003K keyboard is connected. 

2. Select a certain function from the list. 

3. Double-click the item field under the PC Keyboard or USB Joystick column. 

4. Select the compound keys operation or USB joystick operation from the drop-down list. 

5. Click Confirm to save the settings. 
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9.2.6 Alarm Sound Settings 

Purpose: 

When the alarm, such as motion detection alarm, video exception alarm, etc., is triggered, PCNVR can 

be set to give an audible warning and the sound of the audible warning can be configured. 

Steps: 

1. Open the System Configuration page. 

2. Click the Alarm Sound tab to enter the Alarm Sound Settings interface. 

3. Click the icon  and select the audio files from the local path for different alarms. 

4. Optionally, you can click the icon  for a testing of the audio file. 

5. Click Confirm to save the settings. 

Note: The format of the audio file can only be *wav. 
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9.2.7 Email Settings 

Purpose: 

An Email notification can be sent when a system alarm occurs. To send an email to some specified 

receivers, the settings of the Email need to be configured before proceeding. 

Steps: 

1. Open the System Configuration page. 

2. Click the Email tab to enter the Email Settings interface. 

3. Check the checkbox Server Authentication to enable the Email service. 

4. Input the required information. 

SMTP Server: Input the SMTP Server address. 

Port: Input the communication port of Email service. The port is 25 by default. 

User Name: Input the user name of the sender Email address. 

Password: Input the password of the sender Email address. 

Sender’s Address: Input the Email address of the sender. 

Receiver 1—3: Input the Email address of the receiver. Up to 3 receivers can be set. 

5. Optionally, you can check the checkbox Enable SSL to increase the security of email sending. 

6. Optionally, you can check the checkbox Enable Attachment to send email with attachment. 

7. Optionally, you can click Send Test Email to send an email to the receiver for test. 

8. Click Confirm to save the settings. 
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Chapter 10 Web Browsing 

Purpose: 

iVMS-4200 PCNVR can also be accessed through web browsing. It provides the functionalities of live 

view, playback, log management, system configuration, etc. 

10.1 Login 

Steps: 

1. Input the IP address of the PC running PCNVR in the address bar of the web browser, and press 

the Enter key. A login window will pop up. 

2. Input the user name and password of PCNVR. 

3. Click Login. 

Note: You can set the language as Chinese or English in the upper-right corner of the login interface. 

 
 

10.2 Disk Management 

Steps: 

1. Enter the Disk Management interface: 

Configuration->Remote Configuration->HDD Management->Basic Settings 

2. Check the checkbox to select the HDD. You can check the box Select All to select all the HDDs. 

3. Click Format to pre-allocate the selected HDD for record files storage. 

4. Reboot the PCNVR to activate the new settings. The status of the pre-allocated HDD changes from 

Uninitialized to Normal. 

Note: The original data of pre-allocated HDDs will not be deleted. 
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10.3 Camera Management 

Purpose: 

Before doing any operations via the web browser, cameras or video encoders need to be added to the 

system for monitoring and management. You can add devices through the web browser. 

 

Click Configuration->Remote Configuration->Camera Management->IP Camera to enter the Camera 

Management interface. 

 

 

Adding the Camera 

Steps: 

1. Click Add to open the camera adding dialog box. 

2. Input the IP address, user name, password and other information of the camera. 

3. Click OK to add the camera. You can check the status of the added cameras, such as IP address, 

channel number, port, etc., from the camera list. 
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Modifying the Camera 

Steps: 

1. Select the camera from the list and click Modify to open the camera modifying dialog box. 

2. Modify the information of the selected camera. 

3. Click OK to save the new settings. 

 

Deleting the Camera 

Select the camera from the list and click Delete. Then you can remove the selected camera from the 

PCNVR. 

10.4 Record Schedule Settings 

Click Configuration->Remote Configuration->Camera Settings->Schedule Settings to enter the Record 

Schedule Settings interface. 
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Before you start: 

The HDDs of local PC need to be pre-allocated for record files storage. 

Steps: 

1. Select the channel No. from the drop-down list. 

2. Check the checkbox Enable Record Schedule to enable the schedule record function. 

3. Click Edit to open the Template Settings page. 

4. You can set the schedule as Add Day and you can also customize the schedule as desired. 

5. Select the record type from the drop-down list. 5 record types are selectable: 

Normal: for all-day continuous recording. 

Motion Detection: for motion detection triggered recording. 

Alarm: for alarm input triggered recording. 

Motion|Alarm: for alarm input triggered or motion detection triggered recording. 

Motion&Alarm: for alarm input and motion detection triggered recording. 

6. Optionally, you can copy the template settings to other dates. 

7. Click OK to save the settings and close the Template Settings page. 

8. Optionally, you can copy the record schedule settings to other cameras. 

9. Click Save to save the record schedule settings. 

Note: Up to 8 time periods can be set for each day in the record schedule. 
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10.5 Live View 

Purpose: 

On the Live View page, you can view the live video of the added cameras and do some basic 

operations, including picture capturing, recording, PTZ control, etc. 

Before you start: 

Cameras or video encoders need to be added to PCNVR for live view. 

Note: If it is the first time for live view, the system will remind you to install the ActiveX control. Click 

and install the ActiveX control. 

 

Click the Live View tab to enter the Live View interface. 

 

 

Live View Toolbar: 

 
On the Live View interface, the following toolbar buttons are available: 

 Set View 
Set the screen layout mode. 2 types of screen layout modes are 

selectable: 1-Screen and 4-Screen. 

  Start/Stop Live View Start/Stop the live view of all cameras. 

 Capture Capture the picture in the live view process. 

  Start/Stop Recording Click to start/stop the manual recording of all cameras in live view. 

  
Enable/Disable 

Digital Zoom 
Enable/Disable the digital zoom function. 

 Previous Page Go for live view of the previous page. 

 Next Page Go for live view of the next page. 

  
Start/Stop Two-way 

Audio 
Click to start/stop the two-way audio function of the camera. 

  Audio On/Audio Off Click to turn on/off the audio and adjust the audio volume. 

 Full Screen Display the live view in full screen. Press Esc to exit. 

 

Steps: 

1. Click the icon  to select the screen layout mode. 

2. Select the display window for live view. 

3. Double-click the camera name in the camera list to start the live view. 
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4. To stop the live view, double-click the camera name again. 

You can also click the icon /  in the toolbar to start/stop the live view of all cameras on the 

list. 

 
 

10.6 Playback 

Purpose: 

The record files stored on the PCNVR can be searched and played back remotely through the web 

browser. 

 

Click the Playback tab to enter the Playback interface. 

 

 

Playback Toolbar: 

 

On the Playback interface, the following toolbar buttons are available: 

 Set View 
Set the screen layout mode. 3 types of screen layout modes are 

selectable: 1-Screen, 4-Screen and 9-Screen. 

  Play/Pause Resume/Pause the playback of record files. 

 Stop Stop the playback of record files. 

 Slow Forward Decrease the playback speed of record files. 

 Fast Forward Increase the playback speed of record files. 
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 Single Frame Play back the record files frame by frame. 

 Stop All Playback Stop the playback of all cameras. 

 Capture Capture the picture in the live view process. 

 Download Download the record files to local PC for backup. 

  Start/Stop Clipping Start/Stop clipping the record files. 

  Audio On/Audio Off Click to turn on/off the audio and adjust the audio volume. 

 Full Screen Display the live view in full screen. Press Esc to exit. 

 

Steps: 

1. Select the camera from the camera list. 

2. Select the day for search on the calendar. 

3. Click Search. The search results will be displayed on the timeline. 

4. Click on the timeline to specify start time for playback. The timeline indicates the time duration 

for the record files, and the record files of different types are color coded. 

You can click  or  to scale up or scale down the timeline bar. 

You can click-and-drag the timeline to go to the previous or next time period.  

5. Click the icon  to start the playback. To stop the playback, click . 

 

10.7 Log Management 

Click the Log tab to enter the Log Management interface. 

 

 

Steps: 

1. Select the major type and corresponding minor type of log files for search. 
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2. Click the icon  to specify the start time and end time. 

3. Click Search. The search results will be displayed on the list, and you can check the operation time, 

the type, the user and other information of the log files. 

4. Select the log from the list, click Save Log, and you can save the selected log file on the local PC. 
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